
Director 8.5 Tutorial

Packaging and Performance

The following should help ensure your presentations play correctly once burned to CD.
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1 How to maximise the performance of Director movies

1.1 Break up your presentation into manageable chunks for Director to handle. Several
small director movies are better than one

1.2 Keep your file sizes as small as possible

1.3 Use PhotoShop to reduce colour depth of an image, not Director (see Compressing
Images for Director)

1.4 When animating, only change the part of the image that moves. Have separate cast
members for that area

1.5 Reuse cast members wherever possible

1.6 Do not use images larger in size than the Stage, if the surplus area is never seen. Crop
all images appropriately

1.7 Delete any unused cast members

1.8 When saving choose Save and Compact from the File menu

1.9 Use Vector Shapes from within Director to replace bitmaps, wherever possible

1.10 Loop sound wherever possible

1.11 Compress sound and video as much as is acceptable
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2 How to ensure QuickTime movies play well

2.1 Free up memory using the Unload command. This removes cast members from memory
and makes space for the next cast members in line

2.2 Make sure Direct to Stage is selected. Click on the cast member then go to the
QuickTime tab on the Property Inspector.

2.3 Things to Avoid

The following use large amounts of memory or processing. They can interfere with video
playback.

• Using lots of transparency ink effects, such as dissolves

• Stretching large bitmap images for a zoom type effect. (Sometimes these effects
can be better achieved by using frame animation. Instead of Director having to
calculate all the “in between” images, you supply them as separate cast members)

• Sprites larger than the stage

• Playing a sound file at the same time as playing QuickTime movies

• Stretching QuickTime movies in increments other than 100%.

3 How to ensure sound plays well

3.1 Try experimenting with Shockwave Audio or MP3 audio.

3.2 Use standard sampling rates (11.025, 22.050, 44.100).

3.3 Avoid playing too many sounds simultaneously.

3.4 Link long duration sounds as an external file (see 5.2.3).

4 How to prevent problems with fonts

If you use a font that is not present on the user’s machine the user will get an error
message. For anything but the most common web fonts you should embed the font within
the Director movie. This is very easy to do.

Go: Insert > Media Element > Font

The resulting dialog box is more or less self-explanatory. If you are using small font sizes
(below 9 pts) you may find the font displays better if it is imported as a bitmap. You can
select bitmap fonts from the dialog box.

5 How to avoid problems with missing files

Many problems with the final presentation occur because Director cannot find the
resources it needs. In such cases you will get an error message saying a much-needed
file is missing.



5.1 QuickTime movies

These have to be located in the same folder as the Projector. This is because Director
does not store the movie within itself. Instead, it makes a link to the movie and accesses
it remotely. Director assumes that the movie is in the same folder as the Projector. For
your QuickTime movie to play from your CD, the QuickTime movie must be in this folder.

You can also place QuickTime movies in a folder within the folder that contains the
Projector. If, for example, you had 10 QuickTime movies, you could place these within a
folder called “media”. If you do this, make absolutely sure that the QuickTime movies
are within their own folder at the time of authoring. This folder must be inside the
folder containing the Projector. You can check the location of QuickTime movies by
clicking on the cast member, in the Cast. The Property Inspector will then display the
file path under the Member tab.

The non-display of QuickTime movies can be very frustrating. Double check your project
to ensure everything is working as it should be on a different computer.

5.2 Sound Files

The first thing to say about any sound file is that it will be relatively large in file size. With
this in mind, remember to reduce the file size as much as possible by looping the sound
and by reducing its sample rate and / or bit depth.

Choose from 8- or 16-bit depth and a sampling rate of 44.1, 22.050, or 11.025 kHz.

5.2.1 Sound can be played from within Director or from a linked file. If you import a sound file in
the normal way, it will be added to the cast and will be part of the Director movie itself.
When this is called upon to play it will be loaded into memory first. For short duration
sounds, such as beeps or clicks, this works fine. However, longer duration sounds, such
as extended narration, may take up too much memory and adversely affect performance.
For longer duration sounds, linked files generally work better.

5.2.2 To make a sound file internal, import in the normal way.

5.2.3 To make a sound file external (linked), import in the normal way, except, choose Link to
External File from within the Import window.

QuickTime, Shockwave Audio, MP3, AIFF, and WAV sounds files can be linked in this
way.

Remember: external sound files have to be located in the same folder as the Projector.

You can also place sound files in a folder within the folder that contains the Projector. If
you do this, make absolutely sure that the sound files are within their own folder at the
time of authoring. This folder must be inside the folder containing the Projector. You
can check the location of sound files by clicking on the cast member, in the Cast. The
Property Inspector will then display the file path under the Member tab.

6 How to ensure file paths are correct when writing Lingo

If you are using Lingo to open a new movie or to specify a file path, here are some
guidelines:



6.1  Always use relative path names when writing Lingo. For example, if you wrote a script to
play a new movie, it might look something like this:

on mouseUp me

go to movie "newMovie"

end

 “newMovie” is a relative path name. Providing  “newMovie” was in the same folder as the
Projector, the script would work perfectly well.

6.2 However, if  “newMovie” was in a folder called “media”, which was in the same folder as
the Projector, the file path would be incorrect. It would have to be amended as follows:

on mouseUp me

go to movie "media:newMovie"

end

Note: in between “media” and “newMovie” there is a colon. Macs use colons to separate
elements in a file path, not forward slashes.

6.3 Whilst the above script should work, if we wanted to make sure the file path was correct,
we could add a further item to specify the file path. This is a Lingo property called the
moviePath. This returns the directory of the current movie. We could use this to further
amend the script:

on mouseUp me

go to movie the moviePath & "media:newMovie"

end

the moviePath gives the file path to the folder containing the movie that is playing while
“media:newMovie” gives the file path from that folder to the file itself. The & simply joins
the two. The object of doing this is to ensure that whatever Mac this script is run on, the
file path to “newMovie” will always be correct.

7 Sound conflicts

In certain cases sound files can cause problems. It may be that in trying to play a sound,
Director hesitates momentarily or there are glitches.

One reason may be that you have an externally linked sound file playing at the same time
as other memory intensive operations taking place, a QuickTime movie playing for
example. This sort of problem is caused by Director trying to access data from two
locations at once. One solution may be to make the sound file internal. Unfortunately, if
the sound file is large, this may cause further problems. Clearly, in such cases, there are



no easy answers. To minimise the chances of this kind of thing happening, try to ensure
your movies are not more complicated than they need to be.

8 Organising your material for CD

Your Director presentation is likely to play better if it is broken down into smaller units.
The less work the Projector has to do in terms of loading content into memory the better.
Therefore, aim to structure your presentation using many small movies, rather than one
large movie.

Remember: the final CD MUST contain the Projector, all Director movies, any Xtras
needed and all linked media.

9 Improving how quickly your movie loads

9.1.1 Stub Movies

When you create a Projector, the Projector contains the first movie in your presentation.
This could be very large indeed or very small. If you have only one movie, which is very
large, there will be an unacceptable delay before it plays. This is because everything in
that movie has to load into memory before anything happens.

To avoid this problem it is advisable to use a Stub Movie. A stub movie, in its simplest
form, contains a script on the first frame that opens the first movie proper. This ensures
that the Projector loads rapidly. Employing this technique will dramatically improve the
startup time of your presentation.

Script

on exitFrame me

go to movie "intro"

end

If you make a stub movie you will have to add some Xtras to a special folder. See below
for instructions.

9.2 Xtras

An Xtra is a piece of software used to extend Director’s capabilities. By default they are
embedded in the Projector. Whilst this makes for reliable delivery, it can slow down the

Projector

stub.dir intro.dir

other1.dir

other2.dir



startup of your presentation. The best method is to save them in a folder. Both methods
are explained below however.

9.2.1 Embedding Xtras in the Projector

By default Director assumes the Projector is where you want any Xtras to go. If you only
have one movie there is no problem – Director will have done the work for you. If you
have several movies though you will have to make sure all the Xtras for all the movies
are embedded in the Projector. To do this go:

Modify > Movie > Xtras

This brings up a list of all the Xtras used in the current movie. Make a note of the Xtras
required. Then do the same for each movie in the presentation. You should end up with a
list of all the Xtras required. Now go back to the movie that will be the first in your
presentation (probably the stub movie). Go:

Modify > Movie > Xtras

Use the Add button to add any Xtras not already loaded.

9.2.3 Saving Xtras in a Special Folder

Embedding Xtras in the Projector is a reliable method. However, it will cause a delay in
the time it takes for you presentation to display. If you save your Xtras in a special folder,
Director can access them directly. Startup times are thereby reduced.

Each movie you create will require several Xtras. If your movie contains QuickTime, for
example, an Xtra is require. The first task therefore is to find out what Xtras are needed.

Go: Modify > Movie > Xtras

This will bring up a list of all the Xtras needed for that particular movie. Some of these
may not be required for the final presentation however. This is because some Xtras are
only needed for authoring. You can check this by using the Info button.

Make a list of all the Xtras you require. If you have created several movies, you will need
to check each of them as well to ensure all necessary Xtras have been located. Before
you go to a different movie though, carry out the next step.

9.2.4 By default, Xtras are embedded in the Projector. You need to make sure this does not
happen if you want to use this technique. Director needs to access the Xtras from a
special folder you will create. They must not be embedded in the Projector.

With the list of Xtras still open, select the first Xtra in the list. You will see a checkbox
labelled: Include in Projector. By default this options is selected. Deselect each Xtra in
turn.

9.2.5 You should now have a list of all the Xtras needed to make your presentation work and
you should have prevented all your Director movies from embedding Xtras in the
Projector. The next thing to do is create a folder to contain your Xtras.

This MUST be a folder called “Xtras”. It MUST be located at the same level as your
Projector.



9.2.6 Finally, you need to copy the required Xtras from the Director folder on the HD to the
Xtras folder you have created for the project.

Go: HD > Applications > Director 8.5 > Xtras

Important Make sure you copy the Xtras across, not move them. (To copy, hold down
the Alt key and drag)

10 How to avoid white flashes between movies (from Macromedia Tech.
Notes)

Issue: As a projector navigates between movies, a white flicker is visible. This occurs
only when playing the piece on a Macintosh.

Solution

Try both methods listed below to eliminate or reduce the occurrence of a flicker:

10.1 If adjacent movies use different color palettes, the screen can flicker as a result of the
color shift and cause this symptom. To resolve this issue, make sure that all movies in a
project use the same palette.

10.2 Verify that the option "Reset monitor to match movie's color depth" is NOT selected when
creating the projector. This is only pertinent when creating Macintosh projectors.

Note: A slight white flicker will occur as a projector starts on a Macintosh. This is the
normal behavior of a projector initializing.

11 Final checklist

Before you burn your CD

• Ensure that you have saved your Director movie files in the same folder as the
Projector

• Ensure that all Xtras needed are saved in a folder called Xtras in the same folder that
contains your Projector OR You have embedded them within the Projector of the first
movie

• Ensure all linked media is saved within the folder that contains the Projector
• Ensure all QuickTime movies are saved within the folder that contains the Projector
• You have included any Read me files needed
• You have thoroughly tested every aspect of your presentation, preferably on a

different computer
• You have included a Quit button somewhere in your presentation

12 Burning Your CD

12.1 Copy your folder containing the Projector, Director movies, linked media Xtras and so on
to the Temporary Work Folder

12.2 If you want to create a shortcut to your Projector, do the following:

• Create a folder to contain your whole project. This will be your main folder. Name this
appropriately (the name of your project, for example)



• Copy your project folder to the folder you have just created. Name this appropriately
(Project Media, for example)

• Create an alias from the Projector (Command + Alt Drag on the Projector icon). Put
this inside the main folder. The main folder should now contain the alias and the
Project Media folder, containing your entire project. Because the project has not been
disturbed and is still inside its original folder, there should be no problems with file
paths. However, when you burn the CD, you will need to select Resolve Aliases
(see next section)

12.3 Open Toast from Utilities

12.4 Select Files and Folders from the Toast main window.

12.4 Drag the Project Folder or the folder containing the Project Folder, if you have created an
alias, to the centre of the Toast main window.  It will update automatically.

12.5 Click on the Data button. Check your files and folders are in order. If you have created an
alias, select Resolve Aliases. Click on Done to take you back.

12.6 Click on Check Speed. Toast will then calculate the optimum speed for burning your CD.
Click on Done.

12.7 Click on Write. You can choose either to write a session or a disc. Writing a session
enables you burn several times, useful if you are problem solving. Writing a disc is a once
only action. You should use this option to burn your final CD for handing-in. When
prompted, verify your CD to make certain there are no errors.

12.8 Double check your whole project works, preferably on a different computer.

Main folder

Project Folder

Media

Xtras

Projector

Director
movies

Projector
alias


